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Short Description

The QuickManual introduces the new user to the ComicRack software, and makes them feel comfortable using and exploring i...



Description


• Use mouse wheel to scroll this book • Double-click to goto Fullscreen • Single-click to get more options



• Use up/down arrow keys to scroll this book • F11 to goto Fullscreen • F3 to get more options



ComicRack Introduction a quick guide Welcome to ComicRack! ComicRack is the best eComic reader and manager for Windows computers. It is an all-in-one solution to read and manage your comic book library. It is actively maintained, has a strong user base and is FREE. ComicRack uses Comic Book Archive files, which have the extension .CBR or .CBZ and are simply renamed RAR or ZIP files, respectively. Apart from the standard CBR & CBZ formats, ComicRack supports various other file formats also including PDF, CB7(7z), CBT(TAR), DJVU and may add further formats in the future.



If you wish to read this book later, close for now by clicking the button above and re-open anytime from the Help menu.
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What you’ll learn in less than 20 pages! User Interface Showing & Hiding Panels Reading Comics Navigating The Reader Reading Modes Organizing Comics Knowing the Sidebar Working with Pages Searching Comics Configuring ComicRack Adding Info to Comics Fileless Comics Making Lists What are Scripts? Web Comics Exporting Comics Network Sharing ...and much more!



User Interface ComicRack broadly consists of 2 main components, the Reader window and the Browser window. You manage your comic books in the Browser, and you read them in the Reader. The ComicRack Reader and Browser are supplemented by their respective toolbars and tab bars. The Browser is supported by the Sidebar, which carries the library, plus all the reading lists. At the top of the ComicRack window is the Main Menu, and at the bottom lies the Status Bar. The Reader Tab Bar continues into the Reader Toolbar, which contains several buttons and menus required for customizing how comic books are displayed in the Reader.



The ComicRack Main Menu contains a number of self-explanatory menus. If you cannot see the Main Menu, press Alt to make it visible temporarily, or Use the Tools menu (at the far end) to always show it.



Reader Toolbar



Main Menu



Tools Menu



Reader Tab Bar



The Reader Tab Bar shows the tabs for currently opened comics. Scrolling anywhere over the reader tab bar switches its tabs. It continues into the Reader Toolbar.
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Browser Tab Bar



The Tools Menu contains the most important options you’ll need while using ComicRack.



Reader



The Reader is the area where the open eComics are displayed. Just above the Reader window is the Reader Tab Bar on the left, and the Reader Toolbar on the right.



The Browser Tab Bar contains tabs for the Library  Browser, Folders  Browser, and Pages  Browser, which are all integrated with the Sidebar Toolbar and the Browser Toolbar. The Sidebar folders & lists can be opened in a new tab here.



2



Browser



The Browser is the area where the comic books added to the ComicRack library are displayed. This is where you manage and organize your comic book collection.



Sidebar Toolbar



The Sidebar toolbar contains the icons required for working with the sidebar. At the extreme right, the sidebar toolbar contains previous / next arrows for navigating through the sidebar lists and folders. The content of the Sidebar Toolbar changes with respect to the tab open in the Browser Tab Bar.



Sidebar



The Sidebar contains the Library  folder, the default ComicRack folder that contains your entire eComic collection archived with ComicRack. The Sidebar is also needed for creating, organising, and accessing reading lists.
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Status Bar



The ComicRack Status Bar is present at the very bottom of the ComicRack window. At the very left of the Status Bar, the total number (and size) of eComics displayed in the Browser is seen. Next to it is the number (and size) of the eComics currently selected in the Browser window. At the right end of the Status Bar, the eComic display resize slider is present. Left to the resize slider is the page count of the opened eComic, followed by the current page number of the open eComic and the caption of the opened eComic, in that order.



Browser Toolbar The Browser toolbar contains a number of options for viewing a variety of comic layout styles in the Browser. The content of the Browser Toolbar changes with respect to the tab open in the Browser Tab Bar.



Showing & Hiding Panels
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2



3



4
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In its default layout, ComicRack contains as many as 3 ‘hidden’ or ‘optional’ panels. These can be identified by noticing the dotted extenders known as Docking Grips. Clicking on these docking grips toggles off/ on the 3 optional panels, viz. Search Browser, Favorites & Small Preview. Apart from these, there are a few more docking grips that assist in changing the layout of the ComicRack window contents. Although, technically speaking, the Sidebar also is an optional panel, yet it is active in the default ComicRack setup. This is due to the essential functionality of the Sidebar.



Search Browser Docking Grip : Between the Browser Toolbar above and the Browser window below.



Sidebar Button Docking Mode



Favorites Button



Favorites Docking Grip: Between the Sidebar Toolbar above and the Sidebar below. Same functionality provided by the Favorites button.
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Small Preview Docking Grip: Between the Sidebar above and the Status bar below. Browser Docking Grip: Between the Reader Window above and the Browser Tab Bar below. Sidebar Docking Grip: Between the Sidebar on the left and the Reader window on the right. Same functionality provided by the Sidebar button. The position of the Browser in the ComicRack™ window can be changed to suit the user’s choice. The Dock menu (accessed by the Docking Mode button present on the extreme right of the Browser Tab Bar) can be used to place (dock) the Browser to the left, right or bottom position in the ComicRack™ window.
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Favorites Panel



Search Browser
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Small Preview



Reading Comics



1 From the Tools menu at the far right of the Reader Toolbar, click Open Book, and browse to your desired location. Alternatively, double-clicking any supported file in Windows Explorer will launch that file with ComicRack.



2 The Quick Open box can be seen inside the Reader window when no book is open. While the default ComicRack™ setup displays the No book is open message, once you add books to the ComicRack library, the Quick Open box appears, showing all the default reading lists present in Comicrack™. You can set any reading list to be available in the Quick Open box.
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The Reader window is the most important part of ComicRack, as it is where the book pages are ultimately displayed for onscreen reading. Scrolling the mouse wheel moves the open page up or down, and scrolling beyond the end of the page opens the next page of the book.



Navigating the Reader



The Default Mode, displaying the browser and the sidebar, apart from the reader.



The Fill Screen Mode, in which the ComicRack window (with menus & toolbars) fills the entire desktop.



1



2



F11



F3



F3



4



3



F11



The Reader Mode Here the browser and the sidebar are closed, thus providing the complete space in the ComicRack window to the Reader.
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The Full Screen Mode, in which the Reader (with out any menus & toolbars) occupies the entire desktop.



Reading Modes



1



Page Layout: From the Page Layout button on the Reader Toolbar, you get the options for showing one or two pages at a time in the Reader window. You can also use the right to left mode for reading manga.
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Fit Mode: The Fit Mode button on the Reader Toolbar provides options for displaying book pages by fitting width/ height/all dimensions. You can simultaneously choose the option only fit if oversized to make the original page size the limiting factor.
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Zoom: The Zoom button on the Reader Toolbar zooms in/out the book pages, using the preset (100%, 125%, 150%, 200%, 400%) or custom values.
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Rotate Pages: From the Rotation button on the Reader Toolbar, You get the options for rotating the open book left, right, 90o, 180o, or 270o . The Autorotate Double Pages option is quite useful if you are using ComicRack on a tablet PC. Please note that using the rotation option, the pages of the open book are rotated only for display in the reader, while the image files in the book archive are not rotated.
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Apart from the full screen reading mode, ComicRack supports two page display, various zoom modes, auto rotation (for tablet PCs), a right-to-left mode for reading Japanese manga, and more.
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Organizing Comics



1



Adding your comics to the library: From the main menu at the top of the window, click File and then click Add Folder to Library. Browse to where your comics are. Select your comic book folder, and click Ok. ComicRack will scan the folder (and its subfolders) and add all books to the Library.
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Browsing: The Library tab (on the Browser Tab Bar) is the section of ComicRack that allows the user to interact with archived comics via the Browser window. The Views button (on the Browser Toolbar) lets you choose from 3 different views: thumbnails, tiles & details. Double-clicking on a thumbnail/tile/detail row opens up its comic in the reader.
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Group, Stack & Arrange: Grouping, Stacking and arranging your comics help in customizing the view as per your choice. Different permutations and combinations of these 3 options provide a variety of environments for managing your comics. Play with these settings for a while to find the layout that suits you best.
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The ComicRack library is a virtual folder that is the key to managing your comic books. Once you add your comic book folders to the ComicRack library, organizing and finding your desired comics is just a click away. Alternatively, you can use The Folders tab (on the Browser Tab Bar) to browse your computer for comic book folders in a Windows Explorer-like fashion.



Group Views



Arrange Stack



Working with Pages The Pages tab (on the Browser Tab Bar) is the section of the ComicRack browser that allows the display and organizing features for the pages of a comic in the browser window. ComicRack provides labelling (Page Filter) for individual pages of a comic, as Front Cover, Story, Advertisement, Letters etc. The page type can be changed to suit your needs. You get the options for viewing, arranging and grouping comic pages, rotating them to your needs, changing the reading order or adding additional information.



Page Context Menu Saving Pages: Just drag-and-drop the page(s) to any location on your computer from the pages view. Or you can use the Copy Page option, and then paste the page anywhere in either Windows Explorer, or an image editor of your choice.
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Right-clicking on any page opens up the page context menu.



Deleting Pages: From the page context menu, go to the Page Type option. Click on the Deleted option. The page will not show while reading, while it is not actually removed from the comic file.



Searching Comics



1



Quick Search: On the extreme right of the Browser Toolbar is the Quick Search box. It is an on-the-fly filtering tool: simply start typing, and the Browser window will display (as you type) all the items with matching description fields. You can click at the little arrow besides the search box to reveal a number of filtering criteria to make the search results even faster and most specific.



2



Search Browser: The Search Browser is an optional panel present above the main Browser window. As the Search browser opens, a three-part pane will slide down, allowing you to narrow down the visible comics by using three metadata fields. The drop-down menus can be chosen to display the comic book metadata attribute of your choice. Choosing a particular metadata attribute delimits the comic search results in the Browser accordingly.
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If you have got a big comic book collection, finding a single desired comic out of it manually or searching for them in Windows is a slow and long task. Also, the filename is the only searchable criteria. But, once your comic book collection is added to the ComicRack library, you can find them lightening fast! You can even find them by criteria like publisher, writer, genre, published date, and more.



Knowing the Sidebar



The Sidebar contains the Library  folder, the default ComicRack folder that contains your entire comic book collection archived with ComicRack. The Sidebar is also needed for creating, organising, and accessing reading lists. The Sidebar is an essential component of the Browser, and changes its content according to the tab open in the Browser Tab Bar. There are 3 tabs in the Browser Tab Bar, viz. Library, Folders and Pages. Out of these, the Library and the Folders tabs are integrated with the Sidebar, while the Pages tab does not contain the Sidebar.
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1 Reading Lists: Clicking at any list present in the sidebar opens up the contained comics in the browser from where you can choose to read them in the Reader, or simply manage/organize them in the browser. 2 Gauges: These are visual indicators for new/ unread/total books in a list. The Red gauge represents new books added in the past 10 days. The yellow gauge indicates the unread book count, while green one shows the total book count. 3 Sidebar Toolbar: Seen on top of the Sidebar, the Sidebar Toolbar contains buttons for making new lists. The tricolor drop-down menu at its far end can be used to customize the gauges.



4 Sidebar Context Menu: Right-clicking on any folder or list in the sidebar brings up the Sidebar context menu. It contains a number of options, many of which share an overlap with the options from the Sidebar Toolbar.
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1 2



Adding Info to comics



Just like tags in a music file, comic books can contain a variety of metadata. It is the comic metadata that is the basis for managing and organizing your comic book collection with ComicRack. Right-click on any comic book in the browser and select Info to open up the 5-tabbed Info dialog, essential for inputting and editing comic metadata.



1 1 Summary: The Summary tab is an all inclusive box that provides at-a-glance information for your comic books.
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2 Details: This contains the most important metadata fields which are the key for organizing your comic books. ComicRack picks up essential fields like Series, Number, Year from the filename. You can add the rest of them manually. 3 Plot & Notes: This contains additional metadata fields like Characters, Teams, Locations, Scanner Information, and the Web field. 4 Pages: Just like the Pages tab in the Pages Browser, here you can edit individual comic book pages, rotating them to your needs, changing the reading order or the page type. 5 Colors: The Colors tab is used for adjustment of the intensities of the color attributes of the eComic pages, viz. Saturation, Brightness, Contrast, Gamma and Sharpening.
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All eComic formats recognized by ComicRack that are in your library, are stored in the database file (ComicDB.xml), so you can easily backup/restore their metadata. In case of .CBZ (not in .CBR) files, ComicRack also stores metadata as the Comicinfo.xml file within these file formats. Once the Comicinfo.xml file is stored in the .CBZ files, the metadata in these file formats will stay preserved, no matter wherever or how many times you transfer them.



Fileless comics



1 Create new fileless entry: From the File menu, select New Fileless Book Entry. A blank Info dialog box will open, where you have to add the relevant metadata in the details and plot and notes tab. Click the Ok button, and your entry will get saved in the ComicRack library as a fileless comic. You also get an additional Catalog field in the Info dialog. 2 Adding thumbnail to a comic book: You can use the Thumbnail button to browse to the comic cover saved (manually by you) elsewhere on your system. Thereafter, even if you delete the cover from your system, Comicrack™ retains the thumbnail. 3 Convert fileless to a comic book: You can use the link to file button to browse and link a file of any supported format (like CBR, CBZ etc) on your system, thus converting the fileless entry into an actual comic book.
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ComicRack also supports adding ‘Fileless’ comic entries into the database. Some of the scenarios in which this is useful: • If you wish to delete a comic book (or an entire series) from the database (for saving hard disc space, or removing a comic book that you didn’t like), but want to retain the info • If you wish to purchase some comic books (a wishlist), and would like to catalogue their metadata in ComicRack for quick reference Managing fileless comic entries/series is more-or-less similar to their real counterparts, the comic books.



Making Lists



1 Custom List: This is a simple list of comic books, made by manually adding individual comic books to it. To create a new custom  list, either click the new list icon on the sidebar toolbar. Add comic books to this new empty list by either dragging-and-dropping the comic books from the Browser, or right-clicking any (or a group of) comic(s) in the browser to open the browser context menu, and clicking Add to List. 2 Smart List: This is an ‘automatized’ list, in which you create a rule (or many rules), and ComicRack automatically adds all comic books fulfilling the rule(s) to the smart list. As new comic books are added to your library, ComicRack auto-updates your smart lists. To create a smart  list, click the new smart list icon on the sidebar toolbar. In the Edit Smart List dialog box that opens up, pick a metadata field from the leftmost drop-down menu, choose an instruction from the second, and fill in a complete or partial keyword in the third (text) field. You can also make multiple rules and rule groups.
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A Reading  List is a compilation made up from comic books in your comic library. These are analogous to playlists that you make in your music player. You can use lists to organize a group of comic books matching a particular criteria. All the lists are accessed from the sidebar. You can organize any number of lists and smart lists into well defined folders. You can easily rename lists, delete lists, edit smart lists, create, rename & delete list folders, export and import lists.



1 2



Web Comics



1 Getting a Web Comic: Just login to the ComicRack  forum and go to the Web Comics section. Our developers there have already posted a good collection of Web comics that you can download and use.



2 Opening a Web Comic: Double-clicking any web comic (.CBW file) opens it directly in ComicRack and starts displaying the pages as they are downloaded from the web. 3 Updating Web Comics: If your file is in the Library, then the page at which you have stopped reading the web comic should be remembered so the next time you open the web comic, this last page should be displayed instead of the first page. You can also use the Update Web Comics option from the File menu to update all Web Comics in your ComicRack library.
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ComicRack supports Web Comic (.CBW) files. With Web Comics, ComicRack can read comics directly from web pages and display them as if they were standard comic books (CBR, CBZ). Web Comics can be exported to other formats. If the definition supports it, a Web comic can update itself to add new pages (like for daily or weekly comics).



Exporting comics



1 Exporting comics to another format: To convert a comic book to another format, right-click on any comic book in the Browser, goto Export Books and simply choose your format. A batch of comic books, or even your complete library can be batch converted in a similar fashion. If you need more options, you can click the Export Books... option to choose the export location, file format (including .PDF & .DJVU), and options for page format, size & color. 2 Saving pages: You can simply drag-and-drop pages from the Pages  tab (on the Browser Tab Bar), or the Pages tab of the Info dialog to anywhere in Windows explorer. If you also need to convert the page, you can use the Export Page function (from The Reader context menu, seen after right-clicking any page open in the Reader window). This opens a Save Page as dialog where you can choose the page type from JPG/BMP/ PNG/GIF/TIFF formats.
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You can use  ComicRack to convert your comic books (either single, or an entire batch) from one format to another (like .CBZ, .PDF, .DJVU). You can also save individual pages, and also convert them to your chosen format.



Configuring ComicRack



1 Preferences: Open up the Preferences dialog via the Tools menu, or by the Ctrl+F9 keyboard  combo. The Preferences dialog contains 5 tabs, which are the Reader Setup, Libraries, Behavior, Scripts, and Advanced tabs. Each tab contains a number of self-explanatory options for customizing the way you wish to read and manage your comic books with ComicRack. Among other options, It is worthwhile for the best ComicRack experience to switch on the options in the Books section of the Advanced tab. 2 Book Display Settings: Open up the Book Display Settings dialog via the Tools menu, or by hitting F9  on your keyboard. This will allow you to edit the background display of the Comic Reader, as well as choose between display options for the opened comic book itself.
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ComicRack can be adapted to your needs. Optimize page display, change keyboard shortcuts, hide the overlays, manage scripts, share your library in your local network or change the user interface language.



What are Scripts?



1 Download the script you like: Here in this example, we have downloaded the ComicVine Scraper script, the top-rated ComicRack script. 2 Install the script: Simply double-click the downloaded script file, and the Scripts tab in the Preferences dialog will open up, showing the script you are installing. Click Ok, and restart ComicRack. Your script will be successfully installed.



3 Use the script: Most of the scripts can be accessed from their respective icons on the Browser Toolbar. Some of the scripts require going to Browser context menu → Automation. The Comic vine scraper dialog appears. Click the Start scraping button. The scraper will find a number of matches in the Comic Vine database for your selected comic books. Just select the one you want, and the script will download the information from the Comic Vine online database, and automatically fill all the metadata fields in the Info dialog. Easy, isn’t it!
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Scripts are essentially plugins or add-ons that extend the functionality of ComicRack. With scripts, you can batch process books in ComicRack. A number of tedious manual tasks can be accomplished with just the click of a button. This gives you more time to read your comic books than manage them! A large variety of scripts are currently available. The scripts are usually distributed as packaged zip files. These scripts can be freely downloaded from the Index of Scripts section of the ComicRack forum.



Network Sharing



1 Opening Remote Libraries: Click on the Open Remote Library option from the Tools menu. The Open Remote Library dialog will open. The names and description of available libraries could be seen. Double-click on any library name, and ComicRack will retrieve the shared library from the server. The remote library will load in the Browser Tab Bar next to the Library tab. The remote library supports all the functions of ComicRack, just like your library. 2 Enabling Network Sharing: To enable network sharing, go to Tools menu → Preferences → Libraries tab → Sharing section → Click Add Share. Here you can also select if you want to share your complete library or only selected lists. You can also select to make your library password protected (recommended) or editable. Restart ComicRack. Now your ComicRack is ready for sharing your library over the internet. If your computer is behind a router, you will also need to create a new port forwarding for the port 7612 TCP.
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Using the network sharing functionality of ComicRack, you can, over the internet, open the shared library of your friends using ComicRack, and read/download their comic books.



...and much more! We hope that reading this Quick Guide introduces you well to the ComicRack software, and makes you feel comfortable using and exploring it. However, ComicRack has much more to offer than can be contained in less than 20 pages. If you want to know all and use ComicRack to its maximum potential, we suggest you read the ComicRack Manual. This is the official companion to the ComicRack software, and is currently in its 5th edition. You can freely download the manual from the ComicRack forum.



Please support us ComicRack is donation-ware. You are encouraged to donate a small amount to support this project and keep it running. ComicRack has no functional limitation whatsoever if no donation is made. Hundreds of hours of work have been put into ComicRack to make it the best, most versatile and simply the most fun to use comic book reader and manager in the world. Starting out as a small fun project, it has evolved into what you currently see, a multi-language application with it’s own web site and support forums. So if you think ComicRack adds value to your life, give something back. You can reach the Donation page by opening the Support ComicRack dialog from the Tools menu. 10,000s of downloads and usually an average of €10 donations a month do not really fit together. It’s not about getting rich (as you can estimate from the above value), but it is about justifying the time and work put into this and also the feeling that there is some worth in it. So please help to keep this project running.
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